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SUMMARY:
This protocol outlines the procedure for performing deep, whole-cell single-molecule localization microscopy (SMLM) using a spinning disk confocal microscope with optical photon reassignment, thereby enabling DNA-PAINT imaging without the need for custom optics or complex illumination.

ABSTRACT:
Single-molecule localization microscopy (SMLM) enables nanoscale imaging of cellular structures but is typically restricted to imaging near the coverslip due to the limitations of total internal reflection fluorescence (TIRF) and highly inclined and optical sheet (HILO) illumination. Here, a protocol that leverages a spinning disk confocal microscope equipped with optical photon reassignment (SDC-OPR) to perform SMLM in whole cells is presented. This method enables high-precision single-molecule imaging throughout the full cell volume using DNA points accumulation for imaging in nanoscale topography (DNA-PAINT) without the need for custom optics or complex illumination schemes. The protocol provides a stepwise guide on configuring a commercially available spinning disk microscope (e.g., CSU-W1 SoRA) for SMLM imaging, including acquisition parameters optimized for deep imaging. Sample preparation steps are outlined for labeling intracellular targets with DNA-conjugated probes to perform DNA-PAINT imaging, including strategies for multicolor imaging of several targets. Image acquisition is followed by single-molecule localization and reconstruction using standard software packages. Critical considerations for minimizing background, optimizing lateral resolution, and ensuring imaging quality across the full cell depth are also discussed. This accessible protocol allows researchers to perform deep, whole-cell SMLM using standard confocal equipment, expanding the range of biological questions addressable by single-molecule imaging beyond the near-membrane regions.

INTRODUCTION:
Single-molecule localization microscopy (SMLM)1 is a family of super-resolution techniques that achieve nanoscale resolution by temporally separating the emission of individual fluorophores and localizing them with high precision. Successful SMLM requires a high signal-to-noise ratio (SNR) to detect single-molecule events, which has traditionally limited its use to optical setups providing intense, localized excitation. The most common configurations are total internal reflection fluorescence (TIRF)2 microscopy and highly inclined laminated optical sheet (HILO) illumination3. TIRF reduces background fluorescence by creating an evanescent field that selectively excites fluorophores within a few nanometers of the coverslip, thereby suppressing out-of-focus illumination. However, this restriction makes TIRF unsuitable for imaging deeper biological structures, such as organelles extending into the extracellular domain. HILO microscopy provides greater penetration depths, allowing imaging several hundred nanometers above the glass substrate. This comes at the cost of a reduced field-of-view (FOV)4 and uneven illumination with increasingly higher planes, limiting its applicability for larger cellular structures. More recently, light-sheet microscopy (LSM) techniques such as lattice light-sheet5–7 and single objective single plane illumination microscopy (soSPIM)8 have extended SMLM into volumetric and tissue-scale imaging. By shaping the excitation beam into thin, structured light sheets, LSM achieves optical sectioning with reduced background and phototoxicity. SoSPIM captures focal planes orthogonal to the detection axis in a single exposure, enabling fast volumetric imaging with near-isotropic resolution. The soSPIM application has demonstrated 3D SMLM in whole cells and small organelles (>20 μm depth) with down to 40 nm isotropic resolution, and with minimal out-of-focus background9. Despite their strengths, these methods typically require transparent samples, specialized optics, and complex alignment, and remain sensitive to optical aberrations and scattering in thicker specimens.

Confocal microscopy offers an alternative by rejecting out-of-focus light through the use of a pinhole in front of the detector, combined with beam-scanning mirrors. This optical sectioning capability enables deep volumetric imaging with high SNR. In particular, spinning disk confocal (SDC) microscopy combines the speed and wide-field detection of conventional imaging with the sectioning capacity of point-scanning systems10. This is achieved in conventional SDC through the incorporation of a rotating disk patterned with parallel pinholes, often combined with an aligned microlens array. The microlenses collect a substantial portion of the emitted fluorescence and focus it through the pinholes, which reduces the background signal. This configuration provides rapid optical sectioning without the need for specialized optics or additional sample mounting preparation, making it a robust choice that can be readily implemented and optimized for deep volumetric SMLM image acquisition11. 

In this study, the CSU-W1 spinning disk confocal scanner unit equipped with optical photon reassignment (SDC-OPR) is employed. Unlike standard SDC, SDC-OPR introduces a second microlens array that projects the emitted photons onto a complementary pinhole pattern12, to mitigate scattering and recover photons that would otherwise be discarded. This photon reassignment effectively sharpens the point spread function (PSF), enhancing lateral resolution beyond that of conventional SDC while still rejecting out-of-focus light13. Specifically, the SDC-OPR microlens array redirects off-axis photons to their closest origin points, effectively increasing detected fluorescence brightness compared to standard SDC. Furthermore, the resolution benefits of SDC-OPR can be amplified via image deconvolution. Iterative deconvolution algorithms computationally refine the PSF, reduce background, and improve signal-to-background ratio without requiring changes to the optical configuration. This combined approach provides a significant advantage in terms of localization precision over standard SDC for single-molecule localization experiments14.

Here, a robust and reproducible protocol for single-molecule localization microscopy using a spinning disk confocal microscope equipped with optical photon reassignment (SDC-OPR) is presented. This approach combines the nanoscale precision of DNA-PAINT with the speed, FOV, and depth penetration of spinning disk imaging. DNA-PAINT, an adaptation of point accumulation for imaging nanoscale topography (PAINT)15, relies on the transient hybridization of fluorescently labelled “imager” strands with complementary “docking” strands anchored to molecular targets. These reversible binding events generate stochastic fluorescence signals that can be precisely localized, enabling high-resolution reconstruction of cellular ultrastructure. DNA-PAINT enables the use of highly photostable fluorophores, provides tunable binding kinetics for precise control of imaging conditions, and mitigates photobleaching through the continuous replenishment of fluorescent imager strands16.

To ensure reproducibility and specificity, the approach relies on custom DNA–antibody conjugates that link docking strands to secondary antibodies. Detailed sample preparation steps, including antibody–DNA conjugation, are presented to support robust experimental outcomes. The protocol is validated on well-characterized cellular structures such as nuclear pore complexes (NPCs)17 and microtubules in fixed samples, providing a reference point in estimating reconstruction accuracy. Variations in resolution, quantified via localization precision as a proxy, are further assessed as a function of FOV and imaging depth.

In addition, the efficiency of this workflow for multiplexed imaging is demonstrated using Exchange-PAINT18, a strategy that enables sequential visualization of multiple targets with the same dye and a single laser source based on DNA-PAINT. The Exchange-PAINT workflow is applied to multicolor super-resolution imaging of mitochondria, microtubules, and NPCs within the same sample.

Together, this protocol provides comprehensive guidance and key adaptability notes on antibody-DNA conjugation, sample preparation, imaging conditions, and data analysis, enabling researchers to perform reproducible DNA-PAINT imaging on SDC-OPR. By extending high-resolution imaging beyond the depth and FOV limitations of TIRF-based approaches, this method broadens the applicability of SMLM to a wide range of biological contexts.

PROTOCOL: 
The reagents and the equipment used are listed in the Table of Materials.

1. Preparation of buffers

1.1. Cytoskeleton buffer (CB) preparation:

1.1.1. Prepare 10 mM MES (pH 6.1) with 150 mM NaCl, 5 mM EGTA, 5 mM D-glucose, and 5 mM MgCl2 in 1x filtered phosphate buffer solution (PBS).

1.1.2. Store at 4 °C and filter before use.

1.2. 40x protocatechuic acid (PCA) stock preparation:

1.2.1. Dissolve 154 mg of PCA in 10 mL of distilled, filtered water.

1.2.2. Adjust pH to 9.0 with NaOH.

1.2.3. Aliquot and store at -20°C for a maximum of 6 months.

NOTE: If any aliquot appears brown, discard it, as this indicates oxidation. 

1.3. 100x protocatechuate-3,4-dioxygenase (PCD) stock preparation:

1.3.1. Prepare a 50% glycerol solution with 50 mM KCl, 1 mM EDTA, and 100 mM Tris buffer.

1.3.2. Dissolve 2.2 mg of PCD in 3.4 mL of the glycerol solution.

1.3.3. Aliquot and store at -20 °C for a maximum of 6 months.

1.4. 100x Trolox stock preparation:

1.4.1. Dissolve 50 mg Trolox (6-hydroxy-2,5,7,8-tetramethylchroman-2-carboxylic acid) in 215 µL methanol until the solution turns green within a chemical fume hood using appropriate personal protective equipment (PPE). 

1.4.2. Add 1.6 mL of distilled, filtered water. Allow the solution to turn white and begin solidifying. 

1.4.3. Add 175 µL of 1M NaOH 1M. Allow the solution to start turning liquid again.

1.4.4. In 10 µL volumes, continue to add 1 M NaOH until the solution is totally clarified (around 40 µL). 

1.4.5. Aliquot and store at -20 °C for a maximum of 6 months. The final solution appears yellowish.

NOTE: The final 100x solution has a pH of 11, but dilution to 1x results in a pH of 7–8.

1.5. Buffer C+

1.5.1. Prepare 1 mM EDTA, 500 mM NaCl, and 0.02% Tween-20 solution in 1x PBS.

1.5.2. Adjust pH to 7.4 with HCl and/or NaOH as required.

1.5.3. Optional Trolox supplement: Add required volumes of PCA (40x), PCD (100x) and Trolox (100x) stocks to result in 1x dilutions, leave solution to equilibrate for 1 h at room temperature (23 °C) before using.

NOTE: Prepare fresh weekly. If using Trolox, use it within 4 h of mixing.

1.6. Immunostaining buffers (paraformaldehyde PFA, glycine, and triton):

1.6.1. For 4% PFA preparation from a 10 mL 16% PFA ampule: 

1.6.1.1. Within a chemical fume hood, carefully snap the ampule open.

1.6.1.2. Decant 10 mL of 16% PFA into a 50 mL conical centrifugal tube.

1.6.1.3. Perform a 1:4 dilution in 1x PBS to get 4% PFA, carefully adding ~30 mL of 1x filtered PBS to the decanted 16% PFA, so the final volume is ~40 mL.

1.6.1.4. Aliquot into 1 mL microcentrifuge tubes and store at -20 °C until required.

1.6.2. For 60 mM glycine in PBS preparation:

1.6.2.1. Weigh 225 mg of Glycine into a 50 mL conical centrifugal tube.

1.6.2.2. Add 50 mL of 1x filtered PBS.

1.6.2.3. Vortex until fully mixed and filter.

1.6.2.4. Store at 4 °C until required.

1.6.3. For 0.1% Triton X-100 preparation:

1.6.3.1. First, prepare a working stock of 10% Triton X-100 by diluting 1 mL of 100% Triton X-100 into 9 mL of 1x filtered PBS (final volume = 10 mL), pipette and mix slowly to prevent over-bubbling. Store at 4 °C until required.

1.6.3.2. From the 10% working stock, add 0.1 mL of 10% Triton X-100 to 9.9 mL of 1x filtered PBS for the 0.1% final stock, again mix slowly. Store at 4 °C until required.

2. Antibody-DNA conjugation

2.1. Concentrate the antibody using a 100 kDa ultrafiltration centrifugal filter unit :

2.1.1. Wash 100 kDa ultrafiltration centrifugal filter unit with 100 μL of 1x filtered PBS for 30 min at 14,000 x g, 4 °C.

2.1.2. Add 100 μL of antibody with 200 μL of 1x filtered PBS to the previously washed 100 kDa ultrafiltration centrifugal filter unit, spin for 30 min at 14,000 x g, 4° C. Ensure the antibody concentration is greater than 1.5 mg/mL after concentration with the ultrafiltration centrifugal filter. With this method, the ultrafiltration centrifugal filter usually concentrates the antibody by ~3x.

2.1.3.  Invert the 100 kDa ultrafiltration centrifugal filter unit into a clean tube, spin for 6 min at 1000 x g, 4 °C. This is the concentrated antibody in PBS.

2.1.4.  Measure the volume of concentrated antibody to calculate the new concentration and run a UV-Vis absorption spectra with a microvolume UV-Vis spectrophotometer. Set the background to 1x PBS and save the spectra. 

2.2. Reduce the thiolated DNA docking strand: 

2.2.1. Dissolve 7.7 mg of pre-weighted DTT in 100 μL of filtered water, and transfer to a fresh tube.

2.2.2. Add 100 μL of 3 mM EDTA in 1x PBS to the original tube of DTT, vortex, and transfer to the same tube as step 2.2.1, resulting in 200 μL of 250 mM DTT in 1.5 mM EDTA in 1x PBS.

2.2.3. Dissolve the thiolated DNA docking strand into 1x filtered PBS for a final concentration of 1 mM. Record a UV-Vis spectra of the DNA docking strand solution (diluted to 10 μM in 1x PBS) and save it using the microvolume UV-Vis spectrophotometer.

2.2.4. Mix 13 μL of thiolated DNA (1 mM) with 30 μL of DTT (250 mM), shake for 2 h at room temperature (23 °C). 

NOTE: Store any remaining unused DNA docking strands in 13 μL aliquots at -20 °C for future reactions.

2.3. Antibody conjugation to crosslinker:

2.3.1. Dissolve maleimide-PEG2-succinimidyl ester crosslinker in DMSO to 10 mg/mL (23.5 mM). Store in 10 μL aliquots at -20 °C until required.

2.3.2. Mix concentrated antibody from step 2.1 with 20x molar excess of the crosslinker. Incubate for 90 min, shaking, at 4 °C.

2.4. Purify antibody-crosslinker filtering with a 7.0 KDa spin desalting column containing size-exclusion resin (7 kDa molecular weight cut off):

2.4.1. Remove the bottom closure of the 7.0 KDa spin desalting column and loosen the cap. Place it into a protein low-bind microcentrifuge tube. Centrifuge for 1 min at 1500 x g, 4 °C. 

NOTE: Mark the slant of the resin after the first spin. For all subsequent uses of the column, place the slant facing directly out on the centrifuge. Apply samples and washes to the center and avoid contact with the resin bed.

2.4.2. Add 300 μL of 1x filtered PBS to the 7.0 KDa spin desalting column filter, loosen cap, centrifuge for 1 min at 1500 x g, 4 °C. Repeat twice more.

NOTE: Leave the 7.0 KDa spin desalting column with 300 μL of 1x PBS until the antibody-crosslinker reaction is ready; do not allow column to dry out. 

2.4.3. Remove the last 300 μL of PBS wash by centrifuging again for 1 min at 1500 x g, 4 °C.

2.4.4. Apply the antibody-crosslinker solution to the center of the resin bed, dropwise. Place the 7.0 KDa spin desalting column into a clean microcentrifuge tube, centrifuge for 2 min at 1500 x g, 4 °C. The antibody-crosslinker product is now in the microcentrifuge tube; keep at 4 °C or on ice.

2.5. Purify the DNA-DTT mixture with desalting spin columns with Sephadex G-25 (size-exclusion resin for DNA purification):

2.5.1. Vortex the desalting spin columns (DNA purification) so resin is evenly distributed. Remove the bottom closure and loosen the cap, and place it into a clean microcentrifuge tube. 

2.5.2. Centrifuge desalting spin columns (DNA purification) at 735 x g for 1 min to remove storage buffer.

2.5.3. Place desalting spin columns (DNA purification) into a fresh microcentrifuge tube and slowly add the DNA/DTT mixture to the center of the resin. Centrifuge at 735 x g for 2 min. The purified, reduced DNA will now be in the microcentrifuge tube.

2.6. Combine DNA and antibody-crosslinker products:

2.6.1. Add the reduced DNA to the antibody-crosslinker product at a 10x molar excess of DNA:antibody. Mix the purified DNA with the antibody–crosslinker product immediately after purification. This prevents DNA from rebinding.

2.6.2. Incubate overnight, shaking, at 4 °C. 

NOTE: Mix the DNA and antibody in the late afternoon and purify them immediately the next morning. Prolonged incubation of DNA and antibody can result in high DNA:antibody ratios.

2.7. Remove excess DNA with a 100 kDa ultrafiltration centrifugal filter unit the next morning:

2.7.1. Wash the 100 kDa ultrafiltration centrifugal filter unit with 300 μL of 1x filtered PBS for 30 min at 14,000 x g, 4 °C.

2.7.2.  Add the DNA-antibody mixture with 300 μL of 1x filtered PBS to the 100 kDa ultrafiltration centrifugal filter unit and spin for 30 min at 14,000 x g, 4 °C.

2.7.3.  Invert the ultrafiltration centrifugal filter unit into a clean tube, spin for 6 min at 1000 x g, 4 °C. This is the concentrated product in PBS.

2.7.4. Dilute product to 100 μL in 1x filtered PBS.

2.7.5. Record a UV-Vis spectra of the product using the microvolume UV-Vis spectrophotometer, with a background of 1x PBS, and save the spectra. 

2.7.6. Measure the final concentration and DNA:antibody ratio from the spectra. Observe a shift in the absorbance peak of the antibody from 280 nm to 260 nm, due to the extra absorbance from the DNA. Use step 2.8 to determine the concentration and DNA:antibody ratio.

2.7.7. Store the product in the original storage conditions of the antibody used. If freezing, avoid freeze-thaw cycles.

2.8. Calculate DNA:antibody ratio from the UV-Vis spectra:

2.8.1. From the spectra of pure DNA (10 μM in 1x PBS), measure the absorbance values at 260 nm () and 280 nm (). Divide these by the DNA concentration (10 μM) to find the molar absorption coefficients of DNA ( and ).

2.8.2. Repeat for the antibody to find  and , remembering to divide by the concentration of antibody used for the spectra.

2.8.3. From the product spectra, the absorption at 260 nm and 280 nm depends on both the absorbance from the DNA and the antibody:


Where  and  are the concentrations of DNA and antibody, respectively, within the final product. Solve these equations simultaneously to find the molar concentration of both DNA and antibody within the product. Calculate the ratio of DNA:antibody using these concentrations.

NOTE: The concentration of the antibody for the first spectra can be calculated by measuring the volume of antibody remaining after filtration with ultrafiltration centrifugal filter unit 100 kDa filtration and comparing this to the original volume (with known concentration) of antibody used.

3. Cell culture

3.1. HeLa Kyoto mEGFP-Nup107 cells.

3.1.1.  Prepare a stock of cell culture medium, Dulbecco's Modified Eagle Medium (DMEM), supplemented with 10% fetal bovine serum (FBS) and 1% Penicillin/Streptomycin (P/S), and store it at 4 °C. Pre-warm the media 30 min before usage in a 37 °C water bath. Depending on the working conditions, it is recommended to aliquot and filter the necessary amount to prevent contamination.

3.1.2. Seed cells at 2 x 105 cells/mL in 7 mL of pre-warmed supplemented DMEM media in T25 flasks. Place the cell flasks in a suitable incubator at 37 °C and 5% CO2 environment.

3.1.3. Ensure passage every 48–72 h to prevent overcrowding. 

3.1.3.1. Take the T25 flask containing the confluent culture and aspirate media from the flask.

3.1.3.2. Pippett 1 mL of Trypsin EDTA (TE), ensuring full coverage by gently tilting the flask. Incubate at 37 °C for 7 min to allow cell detachment from the flask.

3.1.3.3. Add 2 mL of supplemented DMEM media and triturate.

3.1.3.4. Transfer the cell suspension into a 15 mL conical centrifugal tube with an additional 7 mL of supplemented DMEM media.

3.1.3.5. Centrifuge at 400 x g for 5 min. Carefully check for pellet formation at the bottom of the tube without disturbing it. 

3.1.3.6.  Aspirate media and resuspend the cell pellet in supplemented DMEM media.

3.1.3.7. Seed 2 x 105 cells/mL in a new T25 flask containing 7 mL of pre-warmed media. Incubate at 37 °C and 5% CO2.

NOTE: If unsure of the cell density, one could use a hemocytometer to determine the cell count. It is recommended to start with a 1 mL pellet resuspension prior to counting.

3.2. U2OS CRISPR mEGFP-Nup96 cells

3.2.1. Prepare a 10% FBS and 1% P/S supplemented McCoy’s 5A media, as per step 3.1.1.

3.2.2. Seed cells at 2 x 105 cells/mL in 7 mL of supplemented McCoy’s 5A media in T25 flasks. Incubate at 37 °C and 5% CO2.

3.2.3. Passage every 48 h to keep the culture growth below 80% confluence:

3.2.3.1. Aspirate media from flask and gently wash the adherent culture with 2 mL of filtered pre-warmed (37 °C) 1x PBS.

3.2.3.2. Aspirate PBS and add 2 mL of Accutase, slowly tilting the flask to ensure full coverage, then incubate at 37 °C for 7 min.

3.2.3.3. Add 2 mL of supplemented McCoy’s 5A media and triturate.

3.2.3.4. Add 7 mL of media to the cell suspension and transfer it to a 15 mL or 50 mL conical centrifugal tube for centrifugation. Centrifuge at 400 x g for 5 min and check for pellet formation at the bottom of the tube.

3.2.3.5. Resuspend the cell pellet in supplemented McCoy’s 5A media.

3.2.3.6. Seed at 2 x 105 cells/mL in a new T25 flask with 7 mL pre-warmed media. Incubate at 37 °C and 5% CO2.

NOTE: Warm all solutions added to cells to 37 °C in a water or bead bath. For Accutase, warm only 2 mL aliquots for no more than 5 min to avoid degradation.

4. Immunostaining of Nup96, mitochondria, and microtubules

4.1. Preparing U2OS mEGFP-Nup96 cells

4.1.1. Following the steps outlined in step 3.2, aspirate media from T25 flask and wash the adhered cells gently with 2 mL of 1x filtered PBS.

4.1.2. Aspirate PBS and add 2 mL of Accutase, slowly tilt the flask up and down, and incubate at 37 °C for 7 min to promote cell detachment.

4.1.3. Add 2 mL of supplemented McCoy’s 5A media and triturate.

4.1.4.  Top cell suspension with 7 mL of supplemented McCoy’s 5A media and transfer it to a 15 mL or 50 mL conical centrifugal tube before centrifuging at 400 x g for 5 min. Again, check for pellet formation at the bottom of the tube.

4.1.5. Resuspend the cell pellet in supplemented McCoy’s 5A media.

4.1.6. Seed cells at 1 x 105 cells/mL in 8-well microslides and incubate in the cell incubator (37 °C, 5% CO2) overnight.

NOTE: Seed cells 24 h prior to fixation and immunostaining procedures, to allow adherence.

4.2. Immunostaining U2OS mEGFP-Nup96 cells for Nup96 imaging

4.2.1. After overnight incubation, replace the McCoy’s 5A media in the 8-well microslides with 1x filtered PBS. In quick succession, aspirate the PBS and add the pre-warmed (37 °C) 4% PFA fixation solution in a chemical fume hood.

4.2.2. Allow cells to fix for 30 min at room temperature (23 °C), preferably within the chemical fume hood, before the PFA is washed and waste is discarded. All steps can now be performed at room temperature unless stated otherwise.

4.2.3. Remove the 4% PFA fixation solution and wash the slide 3x 3 min with 1x PBS.

CAUTION: Use PFA in a chemical fume hood while wearing appropriate PPE.

4.2.4. Following fixation, permeabilize the cell membrane by adding 0.1% Triton X-100 in 1x PBS solution. Let it sit for 5 min, then wash 3 x 3 min with 60 mM glycine in 1x PBS, to quench the autofluorescence of residual PFA. 

NOTE: Triton permeabilization solution is extremely time-sensitive and could alter the cell structure integrity if left to sit for too long.

4.2.5. Add 5% BSA in 1x PBS for 1 h in the dark, to block cells prior to immunostaining.

4.2.6. Prepare 20 nM of the DNA-conjugated anti-GFP nanobody in blocking solution (5% BSA in 1x PBS) to prevent unspecific binding blocking. Incubate the slide with the nanobody mixture for 1 h at room temperature (23 °C), then wash the unbound DNA-strands 3 x 3 min with 1x filtered PBS. 

NOTE: Pause point: After fixation, blocking, and addition of antibodies, samples can be stored at 4 °C overnight. This pause point is included primarily due to the time required for sample preparation, rather than being a strict necessity of the protocol. Imaging can proceed immediately after these steps if preferred. 

4.3. Immunostaining of U2OS mEGFP-Nup96 cells for mitochondria and microtubule imaging

4.3.1.  After overnight incubation, simultaneously replace the DMEM media in the 8-well microslides with 200 µL of 0.3% glutaraldehyde and 0.25% Triton X-100 in cytoskeleton buffer (CB) and leave for 2 min for pre-fixation.

4.3.2. Replace pre-fixation solution with cytoskeleton buffer (CB) supplemented with 2% glutaraldehyde. Let it sit for 10 min to fix the cells, then wash the slide 3 x 3 min with 60 mM glycine in PBS, as in step 4.2.4.

CAUTION: Use glutaraldehyde in a chemical fume hood while wearing appropriate PPE.

4.3.3. Add sheared salmon sperm DNA in 3% BSA in 1x PBS for 1 h in the dark, to block cells prior to immunostaining. 

4.3.4. Add 5 µg/mL of DNA-conjugated anti-tubulin (conjugated as described above), for microtubule imaging, and/or 1:200 TOM20 antibody, for mitochondria imaging, in 2% BSA for 2 h at room temperature (23 °C). Wash 3 x 3 min with 1x PBS.

4.3.5. Add 25 nM of DNA-conjugated sdAb anti-Rabbit IgG and incubate for 1 h at room temperature (23 °C). Wash 3 x 3 min with 1x PBS. 

NOTE: Pause point: After fixation, blocking, and addition of antibodies, samples can be stored at 4 °C overnight. This pause point is included primarily due to the time required for sample preparation, rather than being a strict necessity of the protocol. Imaging can proceed immediately after these steps if preferred. 

4.4. Preparing HeLa Kyoto mEGFP-Nup107 cells

4.4.1. Aspirate the media from the T25 flask of HeLa Kyoto mEGFP-Nup107 cells and gently wash the flask with 2 mL of 1x filtered PBS.

4.4.2. Aspirate PBS and add 2 mL of Trypsin EDTA (TE) and slowly tilt the flask up and down, incubate at 37 °C for 7 min.

4.4.3. Add 2 mL of supplemented DMEM media and triturate.

4.4.4. Add cell solution to a 15 mL conical centrifugal tube with an additional 7 mL of supplemented DMEM media and centrifuge at 400 x g for 5 min. Check for pellet formation at the bottom of the tube.

4.4.5. Resuspend the cell pellet in supplemented DMEM media.

4.4.6. Seed cells at 1 x 105 cells/mL in 8-well microslides. 

NOTE: Seed cells 24 h prior to imaging.

4.5. Immunostaining of HeLa Kyoto mEGFP-Nup107 for microtubules

4.5.1. After overnight incubation, simultaneously replace the DMEM media in the 8-well microslides with 200 µL of 0.3% glutaraldehyde and 0.25% Triton X-100 in cytoskeleton buffer (CB) and leave for 2 min for pre-fixation.

4.5.2. Replace the pre-fixation solution with 2% glutaraldehyde in CB and leave for 10 min for cell fixation. Wash 3 x 3 min with 60 mM glycine in 1x PBS.

CAUTION: Use glutaraldehyde in a chemical fume hood while wearing appropriate PPE.

4.5.3. Add 5% BSA in 1x PBS for 1 h in the dark, to block cells prior to immunostaining. 

4.5.4. Add 5 µg/mL of DNA-conjugated anti-tubulin (conjugated as described above), for microtubule imaging in 5% BSA in 1x PBS for 2 h at room temperature (23 °C). Wash 3 x 3 min with 1x PBS. 

NOTE: Pause point: After fixation, blocking, and addition of antibodies, samples can be stored at 4 °C overnight. This pause point is included primarily due to the time required for sample preparation, rather than being a strict necessity of the protocol. Imaging can proceed immediately after these steps if preferred. 

NOTE: When working with alternative antibodies or cell lines, adjust dilution factors for the DNA-coupled antibody or nanobody according to the manufacturer’s recommendations.

4.6. Imaging preparation

NOTE: This step is common to all immunostaining protocols.

4.6.1.  Add 90 nm gold nanoparticles diluted 1:2 in deionized water directly to each well, using the full well volume. Incubate for 5 min to enable future drift correction during imaging. Wash wells 3 x with 1x PBS. 

4.6.2. For Nup96 imaging, add the desired imager strand at 1 nM in C+ buffer supplemented with 1x Trolox, 1x PCA, and 1x PCD.

4.6.3. For Exchange-PAINT of mitochondria and/or microtubules, add the first desired imager strand at 1 nM in C+ buffer only. After imaging the first round, wash the sample thoroughly but carefully after the first imaging round to remove all residual imager strands without moving the sample. Typically, with 5 washes and a 30 s waiting time between them is enough. Then add the second imager strand at 1 nM in C+ buffer only for the second round of imaging.

5. Imaging setup and parameters: Single-molecule localization microscopy

NOTE: Images shown in this protocol were acquired at the LMCB super-resolution microscopy facility at University College London, UK, using a commercially available spinning disk confocal microscope, equipped with an sCMOS camera, and operated via NIS-Elements software. 

5.1. Use a spinning disk confocal system with multifocal excitation and an sCMOS camera.

5.2. Start the system 30 min before imaging: turn on the microscope, camera, and lasers, then start the computer. Wait for the NIS-Elements software to fully load.

5.3. Select the appropriate imaging mode in NIS-Elements: standard spinning disk confocal or SDC-OPR SoRA super-resolution, before setting acquisition parameters.

5.4. Choose the 60× Apo NA 1.49 oil immersion objective for either SDC or SDC-OPR imaging to maximize detection of single-molecule events for improved post-processing.

5.5. Select the appropriate magnification (1×, 2.8×, or 4×) based on the objective, camera settings, and the sample to be studied. Adjust camera binning accordingly: 1× binning for 1× magnification, 2× binning for 2.8×, and 4× binning for 4×. For this setup, this corresponds to effective pixel sizes of 108 nm for 1× (no binning) or 4× (4× binning), and 78 nm for 2.8× (2× binning). Binning is required to obtain pixel sizes suitable for SMLM, approximately matching the PSF standard deviation (typically 100–150 nm)19,20.

NOTE: Higher magnifications (2.8× or 4×) increase laser power density, improving illumination uniformity. This reduces the FOV, so binning must be adjusted proportionally (i.e., 2× binning for 2.8× magnification; 4× binning for 4× magnification) to maintain pixel size.

5.6. Set the exposure time for DNA-PAINT acquisition and synchronize it with the spinning disk rotation speed (adjustable from the CSU-W1 pad). Ensure the rotation speed is a multiple of the exposure time, or press the Sync button to automatically match the closest compatible rpm. Check the screen for striping artifacts, as this indicates unsynchronized settings. For the experiments presented here, a 300 ms exposure time was used. 

NOTE: The rotation speed of the SDC unit spinning and sync microlens-enhanced SoRa disks impacts the beam excitation profile, affecting the average power density distribution over the illuminated area. For this reason, higher exposure times might be needed, than for TIRF setups.

5.7. Configure the laser wavelength, power, and filter wheel (NIS-Elements will suggest an appropriate filter). The laser wavelength will be determined by the spectrum of the imager dye. 

NOTE: In this work, Cy3B was used, which is optimally excited with a 561 nm laser. Cy3B provides the best signal-to-background ratio for DNA-PAINT, making it the preferred choice for this application.

5.8. Adjust laser power via the Laser pad (0%–100%). For DNA-PAINT imaging, set the laser to maximum power (100%). For this system, this corresponds to 1.75 mW (≈ 65 W/cm2) measured after the objective for the 4× magnification, 3 mW (≈ 50 W/cm2) for 2×, and 5 mW (≈ 15 W/cm2) for 1×. 

5.8.1. To record the power after the objective, use a calibrated laser power meter and place the sensor on the microscope stage as close as possible to where the sample plane should be. Take care to avoid contact with the objective lens. Record the power for each configuration used.

5.9. Apply a drop of immersion oil to the clean 60× Apo NA 1.49 oil objective. 

5.10. Secure the prepared sample (from steps 4.2–4.5) onto the stage using a stage adapter. This is important to minimize drift during image acquisition and to prevent movement during buffer exchanges, particularly in multicolor experiments.

5.11. Switch to the brightfield mode within the selected imaging method and focus on the glass plane using nanoparticles as a reference. Activate the Perfect Focus System (PFS). The PFS or a similar system to maintain the focus during the whole acquisition time is crucial because the drift in the axial direction cannot be corrected by post-processing. 

NOTE: The Nikon PFS maintains the sample in sharp focus by continuously monitoring and adjusting the distance between a fixed reference plane and the specimen’s focal plane using an offset lens and a line-CCD detector. By operating independently of image acquisition, the system corrects for focus drift in real time (~milliseconds).

5.12. With PFS active, select the imaging plane of interest. For U2OS mEGFP-Nup96 cells or HeLa Kyoto mEGFP-Nup107 cells, use the 488 GFP signal from GFP-labelled NPCs to identify the flattest cell and determine the optimal focal plane. Use low laser power (~10% of maximum laser power) during this step to avoid photobleaching.

5.13. Define the name and saving path of the experiment. Tick the Time box to set the interval, duration, and number of loops. For continuous acquisition, set the interval to No Delay and enter only the number of loops, which corresponds to the total number of frames. 

NOTE: Make sure the PFS box at the bottom is selected, then press Run. The software will automatically provide an estimated experiment duration and will save the data upon completion. To stop the experiment before it finishes, press Finish to save the current progress, or Abort to end the experiment without saving. 

5.14. For the first protein, acquire 17,000–20,000 frames with a 300 ms integration time. 

NOTE: The concentration of the imager strand needs to be optimized at this step to ensure that single-molecule signals do not overlap while still providing sufficient localizations for reconstruction. This process is similar to a typical SMLM acquisition, where the imager concentration is adjusted to achieve a sufficient number of events for reconstruction while minimizing overlapping. The optimal concentration depends on the structure being imaged. For example, highly labeled structures such as microtubules typically require lower imager concentrations (less than 1 nM).

5.15. Gently remove the imaging buffer for the next protein using a pipette, taking care to avoid disturbing the sample. While monitoring the sample through the microscope camera, carefully add 200 µL of C+ buffer without the imager to wash the first dye.

5.16. Repeat this step until no fluorescence signal from the first DNA-imager solution is detectable (typically 5 washes).

5.17. Add a second imager solution and check that single-molecule events are detected again.

5.18. Acquire 17,000–20,000 frames with 300 ms integration time for the second protein.

5.19. Repeat steps 5.14–5.18 for each additional protein to be imaged.

5.20. For 3D imaging, acquire z-stacks with 0.5–1 µm spacing across the full cell height. This was done with a specific JOB protocol21 designed for the acquisition software (NIS elements) that takes a video of a predefined number of frames at specific z positions, maintaining the PSF throughout the entire acquisition time.

NOTE: The software package, along with detailed user instructions, is provided within the JOB protocol21. A full description of the JOB is also included. The software, named “MultiZ_DNAPaint.bin”, can be downloaded from the Materials tab of the publication. To run the JOB, download this File and import it into the NIS-Elements JOBS Explorer, following the step-by-step instructions provided.

6. Image processing and analysis

NOTE: Images were first processed by deconvolution using a compatible software, followed by single-molecule localization analysis using Picasso software developed by the Jungmann lab16. 

6.1. Open the ND2 image stacks in NIS-Elements AR software.

6.2. For 2D images, select 2D Deconvolution. For 3D images, repeat this procedure for each individual z-stack.

6.3. Choose blind deconvolution and set the noise level to Noisy. Then, input the laser excitation and emission rate, here 560 nm and 571 nm, respectively.  Other parameters are automatically obtained from the ND2 metadata to provide a rough estimate of the source image point spread function (PSF).

6.4. Specify the number of iterations (here, 12), select Create New Document, and press Deconvolve. Save the resulting File after processing. 

NOTE: The algorithm iteratively improves image quality by performing convolution operations that refine the PSF until convergence or the specified number of iterations is reached. Visual inspection of the deconvolved image is recommended. Adjusting the number of iterations is required depending on computational constraints and image quality.

6.5. Load the deconvoluted image stack into the Picasso Localize module. 

6.6. From the menu bar, select Analyze → Parameters, and input the camera-specific parameters according to the manufacturer’s specifications. For the sCMOS camera used in this study (Hamamatsu ORCA-Fusion BT): EM gain: 1, Baseline: 100, Sensitivity: 0.23 (conversion factor, electrons/counts), Quantum efficiency: 0.95 (depending on the used excitation wavelength). 

NOTE: Quantum Efficiency is not used since Picasso version 0.6.0 and is kept for backward compatibility only.

6.7. Set the box side length to 7. The box length is determined using the formula [6 × σPSF + 1], Where σPSF is the standard deviation of the PSF. For all deconvoluted files, the PSF pre-optimization ensures the average standard deviation converges to 1, resulting in a box length of 7. This optimization enhances localization precision, improving the resolution of the reconstructed image.

6.8. Select the appropriate pixel size for the imaging configuration, as per section step 5.5. 

6.9. Next, choose a suitable Min. Net Gradient (e.g., ~1000, depending on the sample) and enable Preview to visualize the detected localizations. Inspect the results and adjust the gradient threshold as needed to minimize background detections and ensure accurate localization.

6.10. From the menu bar, select Analyze → Localize to start spot identification and fitting in all movie frames. After competition, this process automatically saves a .hdf5 and .yaml file. 

NOTE: .hdf5 file stores the localization position of each gaussian fit and more parameters. .yaml file saves information about the video and the analysis procedure and can be inspected using a text editor. 

6.11. Load the .hdf5 file in the Picasso Render module to visualize the reconstructed localization map and perform drift correction. 

6.12. In Picasso Render, select Postprocess → Undrift by RCC. Input a segmentation value, starting at 1000. Upon completion, the calculated xy drift plot will appear. Repeat the process sequentially with lower segmentation values (e.g., 500, then 250), observing gradual improvements in temporal drift.

NOTE: Drift correction can be performed using nanoparticles as fiducial markers, too; however, when imaging planes are elevated, the nanoparticle signal may not be visible. In these cases, only redundant cross-correlation (RCC) drift correction is applied.

6.13. Ensure to save the drift corrected File, selecting File → Save Localizations before closing the Picasso Render window. 

6.14. Load the drift corrected File from step 6.13 into Picasso Filter module for additional post-processing steps, by imposing thresholds on single-molecule localization’s quality metrics, such as: (i) Localization precision (lpx, lpy); (ii) PSF widths (sx, sy); (iii) Photon counts; and (iv) any additional criteria to remove noise, outliers, or poorly resolved spots.

NOTE: lpx and lpy (localization precision in x and y) estimate the uncertainty in the localized spot position along the x and y axes and are calculated based on the Cramér-Rao lower bound (CRLB).

6.15. For filtering one property, select the respective column in the header of the table, and choose Plot → Histogram from the menu. Selecting two columns plots a 2D histogram.

6.16. To filter by a specific property range, click and drag across the desired region within a 1D or 2D histogram. The selected region will appear shaded in green, and any localization events with values outside this range will be instantly excluded from the localization list.

6.17. Filter the data by photons, sx, sy, lpx, and lpy, retaining only the central portion range of each parameter’s distribution to ensure retention of the most reliable localizations. 

NOTE: The central portion of the PSF width distribution is typically between 0.4 and 1.2 × pixel size. Exclude secondary distributions often caused by overlapping signals or poorly resolved spots.

6.18. Save the filtered data by selecting File → Save from the menu. 

6.19. Repeat the process from step 6.1–6.18 for all videos taken for each imager solution.

6.20. Open the filtered File in the Picasso Render module. The intensity in this super-resolved image represents the number of localizations. Contrast can be changed by selecting View → Display Settings and changing the value of Max. density.

6.21. To save the super-resolution image of a single channel, select “Individual Localization precision” from the Blur section. A scale bar can also be added from the Scale bar section. 

6.22. For saving the super-resolution image of all the channels, open all the processed .hdf5 files. The color of each channel can be changed by selecting View → Files from the menu. 

6.23. Align all the channels selecting post-processing → Align channels. 

6.24. Select File → Export Complete Image to save a .png image or File → Export Current View for a specific zoom of the image.

NOTE: Use consistent file naming and documentation practices for reproducibility. Picasso software automatically adds a suffix to each saved File. Cramer Rao Lower Bound and nearest neighbor based analysis (NeNA)22 metrics can be extracted by selecting View → Show info from the menu. The NeNA quantifies the spatial distribution of localized fluorophores by evaluating the Euclidean distance between neighboring localizations. While the CRLB provides a theoretical lower bound for localization precision based on photon statistics and background noise, the NeNA offers an experimental estimate of localization precision derived directly from the dataset itself. For this reason, NeNA is widely used in SMLM as a complementary measure to the CRLB, since it captures not only theoretical limits but also practical influences such as drift correction, fitting errors, and experimental variability. The NeNA metric is extracted from the Picasso Render module. The CRLB of the single-molecule fit is used to determine the localization precision values informed (σSMLM). The reported value is the average between σx and σy, for all the localizations, which are the mode value of the distribution of the localization precision in x and y, respectively. 

REPRESENTATIVE RESULTS:
To demonstrate the super-resolution imaging capabilities of the SDC-OPR system (Figure 1A), its in-plane resolution was assessed by performing DNA-PAINT imaging experiments (Figure 1B) on nuclear pore complexes (NPCs), which are a biological reference structure17. Figure 1C shows a representative DNA-PAINT SDC-OPR image of nucleoporin 96 (Nup96), tagged with monomeric enhanced green fluorescent protein (mEGFPs) and labeled with DNA-conjugated anti-GFP nanobodies, in U2OS cells. The zoomed-in panels reveal NUP substructure, and Figure 1D shows paired Nup96 proteins (indicated by arrows) consistent with the expected 8-fold symmetry of nuclear pores. In Figure 1E, the Euclidean distance between Nup96 pairs was measured by aligning them and plotting the cross-sectional histogram of the summed image (n = 16 pairs). The analysis revealed a peak-to-peak separation of (13 ± 2) nm (Figure 1E), in agreement with results from EM models as well as HILO and TIR imaging23. Each peak fit displayed a standard deviation of 4 nm, confirming the high localization precision (σSMLM = 3.3 nm, NeNA = 4.4 nm) achieved using DNA-PAINT on SDC-OPR. Notably, this precision was maintained across the entire 53 × 53 μm² FOV, which is exceptional for confocal-based systems. 

To demonstrate the capability for multicolor imaging, Nup96, mitochondria, and microtubules in U2OS cells were DNA-labeled for acquisition using Exchange-PAINT18. This technique employs orthogonal DNA imager strands conjugated to a single fluorophore, enabling all targets to be excited with the same laser source (Figure 2A). Rather than acquiring signals simultaneously, it separates them across sequential imaging rounds, facilitating straightforward integration into any commercial SDC-OPR system. Figure 2B shows Nup96 in blue labeled with an anti-GFP nanobody, mitochondria in red with a secondary anti-TOM20 antibody, and microtubules in green with a primary anti–α-tubulin antibody. Notably, the outstanding single-molecule localization precision obtained for single-color Nup96 imaging was preserved across all targets in the multi-target experiment, yielding localization precision values of 3.9 nm for the NPC, 4.0 nm for α-tubulin, and 3.3 nm for mitochondria (Figure 2B panels 1, 2, and 3).  

For large FOV imaging, microtubules in HeLa cells were imaged using various magnifications available on the SDC-OPR system, combined with different camera binning settings to maintain pixel sizes between 78 nm and 108 m (Figure 3). Figure 3A shows the microtubule cytoskeleton of 10 HeLa cells, with colors representing localization precision. At 1× magnification, the average localization precision is noticeably worse compared to higher magnifications (Figure 3B–D), with greater variability observed. This is due to the reduced laser power density over the larger FOV, where the Gaussian illumination profile becomes apparent, leading to decreased precision toward the edges of the FOV. Nonetheless, achieving an average localization precision of 9.5 nm across the expansive 211 × 211 μm² FOV is impressive for confocal-based systems and enables high-resolution investigation of biological heterogeneity. 

Finally, the possibility of imaging whole cells is demonstrated by acquiring DNA-PAINT images of the microtubule network in fixed HeLa cells of a confocal volume of ~500 nm thickness and 1µm z-step using the system's highest magnification (4×, 53 × 53 μm² FOV). Figure 4A presents the single-molecule reconstruction images for each z-plane, along with the corresponding localization precision and NeNA values. In addition, a 3D color-rendered visualization of the microtubule network in the HeLa cell is provided in Figure 4C. As depth increases, the number of detected photons diminishes due to scattering and optical aberrations, resulting in reduced localization precision for both the localization precisions derived from Cramér-Rao Lower Bound (CRLB) (Figure 4A, right) and those calculated using the NeNA metric. Still, the high level of photon collection possible by the SDC-OPR system enables σSMLM ≤ 10 nm for up to 9 μm imaging depth with narrow distributions. Indeed, double-walled filamentous microtubule structures were clearly resolved at various depths: near the coverslip–cell interface, at intermediate axial positions, and at the top of the cell, with peak-to-peak distance between 30 nm and 40 nm (Figure 4C), consistent with reported values24. These results highlight the SDC-OPR’s ability to deliver high-resolution imaging across large FOVs and throughout the entire height of cells.

FIGURE LEGENDS:

Figure 1: In-plane single-molecule localization microscopy of different cell samples and multicolor super-resolution imaging. (A) Schematic of the Spinning Disk Confocal with Optical Photon Reassignment (SDC-OPR) system, featuring a microlens array designed to maximize photon collection. (B) Schematic of DNA-PAINT: Fluorescently labeled DNA strands, known as imagers strands, transiently hybridize with complementary DNA sequences (docking strands) that are anchored to the antibody/nanobody targeting the protein of interest. These short-lived binding events generate fluorescence signals that appear as stochastic blinking. (C) Representative DNA-PAINT image on the SDC-OPR system using 4× magnification of the NPC of U2OS cells. The high-resolution capability is demonstrated in the inset, where individual NPCs are clearly resolved. (D) SDC-OPR-enhanced DNA-PAINT enables visualization of single NPCs, where white arrows highlight characteristic Nup96 protein pairs within the pore architecture. (E) Distribution of distance measurements between Nup96 dimers (n=16 pairs) within single NPC symmetry units. This figure has been modified from Zara et al.14.

Figure 2: Exchange-PAINT for multicolor imaging using an SDC-OPR microscope. (A) Schematic of Exchange-PAINT of three target imaged sequentially. Three protein targets were labelled with either DNA-functionalized antibodies, Fab fragments, or nanobodies. The Cy3B imager strands were imaged sequentially by strand type with wash steps between imaging rounds. (B) Three-color Exchange-PAINT imaging of U2OS cells using SDC-OPR microscopy using 4× magnification, showing microtubules (red; labeled with DNA-conjugated anti-α-tubulin), mitochondria (green; TOM20-targeting DNA-nanobodies), and NPC (blue; mEGFP-tagged Nup96 with anti-GFP DNA-nanobodies). Scale bar: 5 μm. Zoomed-in region emphasizes the enhanced resolution obtained on the SDC-OPR system, focusing on (1) mitochondria, (2) microtubules and (3) NUP. Scale bars = 1 μm. This figure has been modified from Zara et al.14.

Figure 3: DNA-PAINT imaging within large FOVs on an SDC-OPR microscope. Microtubule DNA-PAINT images (anti-α-tubulin labeling) acquired at multiple magnifications: (A) 1× magnification and 1 binning (FOV of 211 × 211 µm²), (B) 2.8× and 2 binning (FOV of 76 × 76 µm²), (C) 4× magnification and 4 binning (FOV of 53 × 53 µm²). Color represents the localization precision from 0–16 nm in the case of 1x magnification and 0–4 nm in the others. (D) Localization precision measured at different distances (in µm) from the center of the FOV for 1× (red), 2.8× (yellow), and 4× (green) magnifications. This figure has been modified from Zara et al.14.
 
Figure 4: Whole cell DNA-PAINT imaging. (A) Left. Volumetric microtubule imaging in HeLa cells via DNA-PAINT acquired using SDC-OPR at 4× magnification, showing axial sections from z = 0 to 9 μm (1 μm steps). Each plane displays z position, localization precision, and NeNA metric. Scale bars: 5 μm (xy). Right. Localization precision versus penetration depth for all planes. (B) 3D render of the microtubule network on the same HeLa cell as in (A). Color represents penetration depth from 0 to 9 µm. (C) Zoomed-in images of highlighted small regions from each penetration depth indicated in (A). This figure has been modified from Zara et al.14.

DISCUSSION:
Super-resolution fluorescence microscopy has broken the diffraction barrier, dramatically enhancing spatial resolution. Yet, its widespread adoption in biological research faces ongoing challenges. Notably, trade-offs between FOV, resolution, and penetration depth make it hard to optimize all three factors simultaneously. These challenges were addressed by utilizing the combined capabilities of SMLM and spinning disk confocal microscopy enhanced by optical photon reassignment (SDC-OPR). By integrating microlens arrays into a standard SDC configuration, as enabled by the commercial SDC-OPR system, photon collection was increased while the effective pinhole size was reduced, leading to significant resolution improvement. In comparison with standard SDC, the SDC-OPR system demonstrated a marked improvement in resolving power, successfully distinguishing features separated by 10 nm14 in the focal plane, whereas standard SDC could only resolve distances greater than 20 nm11. This enhanced resolving capacity underscores the benefit of photon reassignment for achieving molecular-scale separations. Specifically, sub-2 nm lateral localization precision was achieved at the focal plane (z = 0 µm), with lateral precision remaining below 10 nm at depths up to 9 µm, combined with a highly adaptable FOV of 53 × 53 µm² or 76 × 76 µm². Even at a large FOV of 211 × 211 µm², the system delivered an impressive 9.5 nm average in-plane localization precision. These results highlight the system's capability for high-resolution imaging throughout whole cells.

Regarding the coupling reactions for the different antibodies used, the protocol must be carefully followed to ensure an optimal antibody-to-DNA ratio. For primary antibodies, a maximum of four DNA strands can be attached per antibody. Exceeding this ratio may reduce localization precision and could adversely affect quantitative measurements, such as those performed in qPAINT25. Therefore, it is critical to verify the ratio using a microvolume UV-Vis spectrophotometer, ensuring a final 1:1 ratio between DNA and antibody.

A critical step in obtaining high-quality super-resolution images of microtubules is proper fixation. Conventional fixation methods relying solely on high concentrations of PFA often disrupt microtubule structures. Instead, using glutaraldehyde (GA) alone or in combination with PFA significantly improves structural preservation26,27. 

For optimal imaging, a high numerical aperture (NA) objective is essential to maximize photon collection per single-molecule event. In the commercial SDC-OPR system, the laser power is intentionally lower than in conventional TIRF microscopes used for SMLM to minimize sample photobleaching. While DNA-PAINT eliminates photobleaching concerns and could theoretically employ higher laser power, current commercial systems impose limitations, necessitating longer exposure times compared to TIRF illumination. Furthermore, because illumination in SDC-OPR is confocal, molecules are not continuously excited during the exposure. As a result, longer exposure times are necessary relative to continuous TIRF illumination; in this study, an exposure time of 300 ms was used. However, depending on the resolution requirements of a given experiment, shorter integration times (e.g., 150–200 ms) can be employed with minimal loss of resolution28. 

Optimizing the concentration of the imager strand is a critical step to ensure that single-molecule signals remain well separated while still generating enough localizations for accurate reconstruction. This adjustment is analogous to standard SMLM acquisitions, where the balance between event density and signal overlap is carefully controlled. The optimal imager concentration should be adjusted for each different target. For example, for microtubules, an initial imager strand concentration of less than 1 nM is recommended, with adjustments made as needed. 

Maintaining stable focus during prolonged acquisitions is critical, as axial (z) drift cannot be corrected post-processing. Lateral (xy) drift can be compensated via RCC or fiducial markers. In this setup, the microscope’s Perfect Focus System (PFS) ensures focus stability over hours of imaging.

In summary, the integration of SMLM with SDC-OPR provides a powerful platform for high-resolution imaging deep within whole cells, overcoming traditional trade-offs between resolution, depth, and FOV. However, to fully realize the system’s capabilities, meticulous attention to experimental conditions is essential, from antibody conjugation and fixation to acquisition settings and data processing. Each step, from sample preparation to drift correction, plays a critical role in achieving reliable, high-precision data. With careful protocol optimization, this approach offers a robust and versatile solution for quantitative, nanoscale imaging in complex biological samples. This protocol is expected to assist the community in adopting single-molecule localization microscopy and in obtaining super-resolved images from sample planes that are challenging to access using conventional TIRF or HILO illumination. Both objectives are facilitated using commercially available microscopes that are typically found in microscopy facilities worldwide.

In terms of other and future applications, the method is applicable to whole cell samples as well as to more complex tissue samples at greater imaging depths, as demonstrated in previous studies14. Unlike approaches that require physical sectioning, this technique enables volumetric imaging of intact tissues, preserving native architecture and minimizing artifacts introduced by physical sectioning. The use of smaller affinity probes, such as nanobodies, further enhances tissue penetration compared with full-length antibodies, allowing more uniform labeling throughout thick samples. This approach opens the door to studying cellular organization and molecular distributions in situ with higher fidelity. Beyond these applications, the strategy also lends itself to high-throughput screening of nanostructures and biomolecular assemblies, enabling systematic investigations of structural heterogeneity and function. In addition, recent developments in DNA-PAINT have yielded self-quenching imager probes, either based on dye–quencher or dye–dye interactions29–31, which effectively lower background signals, increase fluorescence intensity, and enhance spatial resolution, enabling faster acquisition rates. Integrating these fluorogenic probes into the SDC-OPR framework has the potential to further boost both imaging speed and resolution. Combining these advances with the strengths of the SDC-OPR system could expand its applicability to more complex biological specimens, establishing the platform as a flexible tool for detailed mapping of cellular and molecular structures in a wide variety of tissues.
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